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About this Guide

Audience and Purpose

This guide is for D&B360 for Microsoft Dynamics CRM 2011 and Microsoft Dynamics CRM 2013 users who
plan to take advantage of the rich features and benefits of D&B360 in their CRM environment.

If you are interested in more training and education about using our products, learning opportunities are
available here: D&B360 Training and Education.

Conventions

Note: Notes mean reader take note and provide helpful suggestions.

(1) Important Note: Important Notes mean reader be careful. In this situation, you might do something
that could result in loss of data.

In sections that include instructions for using the D&B360 and CRM graphical user interface (GUI):

« Text in bold indicates the name of a window, tab, field, area, or button that you click or interact with.

e Text in monospace indicates a directory path or a command that you need to type in the command-
line interface.

Navigating in the PDF

Note: To download the free, latest version of Adobe Reader, go to this web site:
http://get.adobe.com/reader/.

1. To return to the page you were on after you click a cross reference link, press Alt + Left Arrow.

2. To return to the first page of the document, press the Shift + Home.

3. To navigate in the PDF file or change the Adobe Reader settings, on the Adobe Reader menu,
select View > Page Navigation, Page Display, and Zoom.
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Related Documentation

For more information about using the Microsoft Dynamics CRM, refer to the CRM documentation.
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1 Introduction to D&B360

Welcome to the D&B360 Administration and Installation Guide for Microsoft Dynamics CRM, which connects
you to customer and prospective customer data that only D&B can provide — plus relevant Rest-of-World
content, all within your instance of Microsoft Dynamics CRM.

Product Benefits .o il 11
GUIde Ob eIV S 1-2
Guide Organization ... .. 1-2
DRB360 PaCKages ... 1-3
Paid SUDSCIIPtIONS . 1-3
Trial SUDSCIIPEIONS oL 1-4
Credit Consumption RUIES ... 1-5

Product Benefits

With D&B360, you finally get the business insight you need, the D&B data quality you want, and the ease-of-
use you deserve.

DSB- - - Now you can see all angles of your prospects and customers within your
- CRM:

‘-" « Know your customers better.

« Acquire new prospects.

« Sell deeper into organizations.

« Improve salesperson effectiveness.

©Dun & Bradstreet, Inc. 2013-2014 1-1
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1 Introduction to D&B360

D&B empowers you with relevant and credible information, facilitating your role as a trusted advisor to

enable new sales.

See New Opportunities

Seeing your customers and prospects in a new way can uncover new
information and new-sale entry points.

Accelerate Your Sales Cycle

Once you establish relevance and credibility, customers will trust you with
their business.

Expand Your Customer
Footprint

Build customer relationships on a foundation that is based on relevance,
credibility, and trust.

Position Your Success

With D&B360, you have a powerful tool that helps you to better understand
your customers pain points, respond to their needs, and ultimately
positions you to win more business.

The D&B360 platform features On-demand access to D&B data, automatic
refresh and synchronization with the D&B database, and seamless
integration of rest-of-world data.

Guide Objectives

The D&B360 Administration and Installation Guide for Microsoft Dynamics CRM provides instructions for the
commonly used D&B360 functions for enhancing your working experience.

Guide Organization

After your Administrator has added D&B360 to the Microsoft Dynamics CRM, new options (on the left menu)
and new icon links (in the ribbon) will display and provide access to new features and functions. In some
menus, like Account Record for example, you will see links on both the left side of the window and in the

ribbon.

E Dashboards DE&EB360

5, B EE % M
L L 3 -84 L 84 D&B
Al:':':'l._.ll'lts With Leads With Contacts With D&E Build A

D&E3E0 D&E3E0 D&E360

Create New

©Dun & Bradstreet, Inc. 2014
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Note: Some additional functions are used by the D&B360 Administrator. If you are not authorized to use
them, you will not have access to them. If you are authorized to use these functions, refer to the D&B360
Administration Guide for more information.

D&B360 Packages

The D&B360 features are available in the packages described in this section.

Note: D&B People are considered to be premium if direct contact information for them is available to
download.

Paid Subscriptions

Person Credit « Imports of premium people are limited and charged against your contact
credits. That is, D&B only charges you the first time you import a specific
premium person. D&B does not charge any subsequent imports of that person.

e For each premium import, one credit is consumed.

« Imports of non-premium people are unlimited, and importing them is not
charged against your credits.

For example:

o When you import multiple people that includes 20 premium people, and 5 of
these were previously imported, D&B charges you credits only for the 15 contact
credits that were not already imported.

e When you import a single person that is a previously imported premium person,
you are not charged a contact credit.

Company Credit | Company imports are unlimited for paid customers, and D&B does not charge credits
for them.

©Dun & Bradstreet, Inc. 2014 1-3
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Trial Subscriptions

Person Credit The contact credit limit represents the combined number of premium and non-
premium D&B people that customers can import.

For example, a user with a trial credit limit of 25 could import:

e 20 premium and 5 non-premium people; or

e 10 premium and 15 non-premium people, and so on.

Company Credit Company imports are limited and tracked for trial customers.

Note: Batch Match Records, Batch Refresh Records, and additional contacts are available as an add-on
package. Contact your Sales Representative to include this in your package.

Note: De-duplication Check, De-duplication Fix, De-duplication Prevention, and Duplicate DUNS reports
are included. However, these features do not perform optimally without DUNS numbers appended to all
records by using Batch Match or the DUNS Import Tool.

©Dun & Bradstreet, Inc. 2014 1-4
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1 Introduction to D&B360

Credit Consumption Rules

D&B People are considered to be premium if direct contact information for them is available to download.

Person Credit

e Imports of premium people are limited and charged against your contact
credits. That is, D&B only charges you the first time you import a specific
premium person. D&B does not charge any subsequent imports of that person.

e For each premium import, one credit is consumed.
« Imports of non-premium people are unlimited, and importing them is not

charged against your credits.

For example:

o When you import multiple people that includes 20 premium people, and 5 of
these were previously imported, D&B charges you credits only for the 15 contact

credits that were not already imported.

e When you import a single person that is a previously imported premium person,

you are not charged a contact credit.

Company Credit

Company imports are unlimited for paid customers, and D&B does not charge credits
for them.

Person Credit

The contact credit limit represents the combined number of premium and non-
premium D&B people that customers can import.

For example, a user with a trial credit limit of 25 could import:

e 20 premium and 5 non-premium people; or

e 10 premium and 15 non-premium people, and so on.

Company Credit

Company imports are limited and tracked for trial customers.

1-5

©Dun & Bradstreet, Inc. 2014



2 Getting Started with D&B360

Accessingthe D&B360 WiNdOW . . ... . 2-1
Accessing D&B360 through Microsoft Outlook ... ... i 2-1
Using D&B360 Rest of Woorld ... o 2-3
Identifying D&B360 Standard Options and Icons ... ... . 2-7
D&B Standard OptioNns ... ..o 2-7
D&B Standard ICONS .. ... o 2-7

Accessing the D&B360 Window

After your administrator has added D&B360 to your CRM, you are ready to go.

File Accounts Wiews Charts Add Customize D&B360

= B, B B B
Accounts With Leads With Contacts With Build A About
DE&B360 DE&EB360 DE&B360 List DE&EB360

Create New D&E Build A List  Maore Info

e To log in to the Microsoft Dynamics CRM, type your user name and password.

Accessing D&B360 through Microsoft Outlook

After your administrator has configured D&B360 to integrate with Microsoft Outlook, D&B360 displays in
your Outlook application.

1. In the bottom left corner of your Outlook window, click DnB360, or the name of your D&B360 instance.

©Dun & Bradstreet, Inc. 2013-2014 2-1
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2 Getting Started with D&B360

4 kLl 3

Click
DnB360.

2. Inthe Dnb360 area, click Sales.

Add-Ins

v @

;.Hume
d =

Conferencing

Help

E\ D&B Lookups
L ﬁ Resource Center

Record and track people, customers, suppliers, or colleagues
with whom your organization does business.

Competitors

Track information about companies that compete against your
organization ar even for a specific opportunity with a
potential or existing customer.

Sales Literature
Store single or multiple documents of sales literature.

Orders

Create and edit orders, Recalculate changed orders, lock
pricing, and create invoices from existing orders.

Quick Campaigns

Quickly connect with a select group of customers to tell them
about new products and promations, This activity can be
done through letters, phone calls, e-mail messages, and more,

New Mew Import Advanced
Activity = Record - Data Find
New Toaols Help
4 DnB360 23 <
> [Z] Workplace Which area would you like to work with?
> [E55 sales Click -
> [By Marketing Sales. =) What's New % Leads
B ﬂ Service Stay up to date on the latest happenings and keep in touch Locate a prospect or potential sales opportunity. Convert
= with your colleagues. qualified leads into accounts, contacts, and opportunities.
- d Settings
> [J Business
> £3 System Zf Opportunities |2 Accounts
> C3 Customization Create records to track potential revenue-generating sales for Record and track the companies that your organization sells
b B cent an account or contact while performing the necessary products or services to.
(33 Process Center tracking from the beginning of the sales process through
4[] D&B360 completion.
[T pag3s0 administration
B pas callout Logs 59 Contacts &

Marketing Lists

Create groups of existing or potential customers for a
marketing campaign or other sales purposes.

Products

Track information about produdts, including their pricing
information,

Quotes

Create a formal offer for products and services, proposed at
spedific prices and related payment terms, which can be sent
to a prospective or existing customer.

Invoices
Locate orders that have already been billed.

Goals
Create and edit goals.

The Dnb360 menu bar and features display in your Outlook application.

©Dun & Bradstreet, Inc. 2014
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Getting Started with D&B360

>;ﬁ Workplace
A.!E Sales
(5] What's New
ff_?b Leads
Lj Opportunities
(= Accounts
fi=| Contacts
"@ Marketing Lists
a Competitors
(7@ Products
*| Sales Literature
Quotes
71| Orders
|j Invoices
@ Quick Campaigns
@ Goals
Goal Metrics
E Rollup Queries
>|§j Marketing
>ﬁ Service
4 I_E] Settings
> [ Business
= [ System
=[] Customization
= [ Process Center
4[ | D&B360
E]_j D&EB360 Administration
B paE callout Logs
E\ D&EB Lookups
> Qﬂ Resource Center

1. Import

+ Import from Files
F About Importing

My Active Accounts s Y

Search My Active Accounts

[ | Account Name

(=5 * ) Evo Travel

[ A Store (sample)

[ Abilene Eye Institute

[3 Advanced Components (sample)
[3 Affordable Equipment (sample]
[ Amazon Co Ltd

[ Apple Inc.

(1 Dmsir frmmmimlnl

4
[31 - 50 of 50

" J Evo Travel
Primary Contact

Credit Limit

= = Microsoft Outlook
Accounts View Charts Add Customize DnB360 Add-Ins Conferencing
Accounts  Leads With  Contacts DnE Build About
With DnE360 DnB360 With DnB360 Industries A List DnB360
Create New DnE Build A List| More Info
4 DnB360_2.3_BetaRelease -
- Get Started with Accounts

An account is a company or corporation that you do business with.,

2. Use

F About Quick Campaigns
+ Detect Duplicates
=+ Set Synchronization Options

3. Modify & Manage

+ Create Custom Views
+ Set Up Duplicate Detection
+ Customize Accounts

~

Main Phone Address 1: City Primary Contact
Dallas
555-0138 Renton Adrian Dumitrascu [sample)
Abilene
5550135 Dallas Erain LaMee [sample)
5550182 Santa Cruz Cat Francis (sample]
Tucson
Cuperting
ccoon17a [IP——— Fablamm b (el

Preferred Meth...  Any

Annual Revenue

Cwner
$250,000.00

Click on a photo to see social network updates and email messages from this person.

Search cannot return results for this view. Click here for more information.

Using D&B360 Rest of World

5 [Cre ]

E-mail [Primary Contai

someone_a@example

someone_b@example
someone_c@example

-
....... A s e

>
Pagel

8 Kelly Todd

On the D&B360 Rest of World area for an account, the Latest News about a company and its management
displays. You can also set alerts to receive email notifications about news and management changes for a
specific company. Click a news heading link to open that story in a new window.

©Dun & Bradstreet, Inc. 2014
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2 Getting Started with D&B360

~ D&B360 Rest of World

Latest News

™ Interview: Deepak Giridharagopal on Puppet, Imm Click a linkto open
Systems with PuppetDB InfoQl 0&6-Feb-2014
Bio Deepak Giridharagopal is Director of Engineering a e lead
engineer for PuppetDB. Prior to joining Puppet Labs, he was F’rmcmal Engmeer at
DelliMessageCne, using Clojure to manage and monitor thousands of production
systems. Code Mesh Londaon is an annual conference dedicated to non-

mainstream technologies. In 2013 it featured talks from over 50 inventors

zing

M Dell Shows Proof-Of-Concept 64-Bit ARM Server Tech \Week Europe 06-Feb-2014
Dell has developed an ARM-based proof-of-concept microserver that company
officials hope will help expand the ecosystem around G64-bit ARM server
processors . The system is being housed at the Dell Solutions Centre in Texas
and can be remotely accessed by organisations and programmers for testing and
development, Stephen Rousset, director of Data Centre Solutions (DCS) at Dell,
zaidina

M Dell's Latest Laptop Runs Windows 8, 05X The Digital Reader 05-Feb-2014
Dell has been working strenuously to reinvent itself ever since it went private last

L Thomas W Sweet MOVED to Chief Financial
Officer 24-Jan-2014

_l_ Brian Gladden, Chief Financial Officer LEFT 24-
Jan-2014

L Bill Rodrigues MOVED to President, Maorth
America 18-Mov-2013

L Paul Henri Ferrand, President LEFT 1&-Nov-
2013

_l_ Greqg Davis MOVED to Vice President of
Software and Peripherals 18-Mow-20132

L Steve Felice, Chief Commercial Officer LEFT
15-Mov-2013

year, and that includes trying products that no one else would consider. While many device makers have tried combining Windows and
Android, Windows and Windows Mobile/Phone, or some other combination of disparate 0OSes, Dell went in an entirely different direction.

Take the new XP3 15 laptop, for

Setting Alerts

If you have already set alerts, the On button displays next to Alerts. If you haven't set alerts, the Off button

displays next to Alerts. To set alerts:

1. Ona D&B360 Account page, click D&B360 Rest of World.

2. Onthe D&B360 Rest of World area, click Alerts to set up your email alerts.

~ D&B360 Rest of World

Latest News

3. Inthe window that opens, type or enter your information in the fields that display and select your Time

Zone.

©Dun & Bradstreet, Inc. 2014
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4. Click Save Changes.

| Puppet. Immutable Deplovments. Analvzina 1@«”&5 W Sweet MOVE
C

eb-2 er 24-Jan-2014

iwof We need some information to setup your email ) )
gP alerts. rian Gladden, Chief Fin
nan; In-2014

r”mtl Your name | || | ill Rodrigues MOVED tc
eatl

Enter your criteria

ARI Company
| and select your

roof
) Time Zone.
osys Email | |
use
i:?;rl Time Zone | Eastern Standard Time Lzies R IRE

teve Felice, Chief Com
So that we can send your alertz at the beginning of 3 _-Nov-2013

8, C your day.

1 reil Click Save
5 Cancel ReETCEEENLEE ﬁ g lm bi
iilafl mtirc

A message displays that your settings were updated, and the Alerts button changes to ON.

~ D&B360 Rest of World

Latest News

Your settings have been updated successfully.
aerts [N

Managing Alerts and Triggers

1. On the D&B360 Rest of World area, click Manage Alerts.

Clck Manage
oM Manage Alerts Alerts.

2. Click the Manage My Alerts tab to display Your Alerts.

3. Next to a company name whose news you have subscribed to, click Subscribed to toggle to
Unsubscribed.

Click Unubscribed to toggle to Subscribed

©Dun & Bradstreet, Inc. 2014 2-5
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~ D&B360 Rest of World 1

< Back My Recent Alerts Manage My Alerts Manage My Company Triggers

powered by EiFirstRain

Your Alerts Save Changes
Your Custom Daily Alert emails will be sent to arnolda@dnb.com &

and will include these companies.

Click Subscribed to

Subscribed Dell Inc. toggle to
| Subscived | I

Click Sawve
Changes. ) Save Changes

4. Click Manage My Company Triggers to specify the type of information about a company that you
want to receive in your news alerts.

5. Next to each trigger, click Active to toggle to Inactive.
—or—
Click Inactive to toggle to Active.

6. Use the scroll bar to display all of the triggers.

7. Click Save Changes.

~ D&B360 Rest of World

< Back My Recent Alerts Manage My Alerts Manage My Company Triggers

powered by EFirstRain

Changes. .
Your custom company alerts will focus on developments related to the following Save Changes
business triggers.

TRIGGERS FOR COMPANY ALERTS

Inactive Market Share Information

: Click Active to toggle
Active Customer Wins or Losses to Inactive.

Active M&A and Spin-offs

©Dun & Bradstreet, Inc. 2014 2-6
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Identifying D&B360 Standard Options and Icons

D&B360 provides standard icons and link options that make it easy for you to access and understand the
information you need.

D&B Standard Options

D&B Data Allows you to change or remove D&B data (including company, contact, and lead
data) about an existing account, or to add D&B data to an account in your database
that does not yet include D&B data.

D&B360 Refresh Imports the most current D&B data for a specific account and performs a stare and
compare for the data in the Account object compared to the D&B360 object.

D&B360+ Displays all of the D&B data licensed by the company for a specific account. Data is
only for the company and does not include contact or lead/opportunity information.

D&B Contacts Searches for contacts associated with a D-U-N-S Number or Company Name and
create leads/opportunities or contacts from them.

D&B360 View Identifies related accounts within your Account object. You can also bring in family
members for cross-sell opportunities.

D&B Look-A-Like Searches for other companies that have similar attributes to their best customers.

D&B Competitors Accesses a list of competitors, assembled by D&B’s editorial team, that are associated
with a D-U-N-S Number or Company. You can use this list for creating accounts,
contacts, or leads/opportunities.

D&B Industry Searches for industry profiles associated with a D-U-N-S Number or Company to
quickly gain powerful insight that accelerates the sales cycle. Industry profiles are
powered by First Research industry experts

D&B Financials Searches for additional financial data specific to your D&B360 accounts such as
annual income statements, growth rates, per share data, and more associated with a
D-U-N-S Number or Company.

D&B Standard Icons

) The yellow circle indicates that you need to update or refresh the window.

©Dun & Bradstreet, Inc. 2014 2-7
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The gray circle indicates that you do not need to refresh the window

A yellow triangle with the letter A indicates an existing account. Click this icon to view that
account.

A yellow triangle with the letter C indicates an existing contact. Click this icon to view that
contact.

A yellow triangle with the letter L indicates an existing lead. Click this icon to view that
lead.

Use the pencil icon to merge the details from a D&B Contact with a contact that has
previously been set up.

O S\ || > @

The green light indicates accounts that are considered a low risk of paying their bills in a
delinquent manner over the next 90 days.

The yellow light indicates accounts that are considered a medium risk of paying their bills
in a delinquent manner over the next 90 days.

Q The red light indicates accounts that are considered a high risk of paying their billsin a
delinquent manner over the next 90 days.

©Dun & Bradstreet, Inc. 2014 2-8




3 Creating a New Account in D&B360

D&B360 makes it easy for you to create a new account. You can leverage D&B data with D&B360 searches
that give you targeted lists to work with.

Creating a New Account Using Name and Address ... ... ... i e 3-2
Creating a D&B360 Account Based on a List of Criteria ... . ... . .. . 3-5

Criteria Cat O IS e 3-7
Creating a D&B360 Account Based on Attributes of a Specific Account ... .. ... 3-8
Creating a D&B360 Account from Records Related to Existing Accounts ... ... .. ... ... 3-10

Reviewing Results when Searching by Family Tree Hierarchy ... . ... ... . ... 3-12
Creating a D&B360 Account from Competitors ... .. .. 3-12

Note the following:

A gold star displays next to the first record and represents the Best Match found based on
your search criteria. The more details you provide, the better the results.

A A yellow triangle with the letter A indicates an existing account.
A\ A yellow triangle with the letter Cindicates an existing contact.

A A yellow triangle with the letter L or Oindicates an existing lead or opportunity.

Note: When you click or select the name of a company, a Company Overview window opens that
displays details about that company including D-U-N-S number, name, location, address, a synopsis, and
more.

Note: To export Company Results to an Excel or other spreadsheet program on your local directory, click
the spreadsheet icon.

©Dun & Bradstreet, Inc. 2013-2014 3-1



D&B360 User Guide 3 Creating a New Account in D&B360

After you create or add a new account, the Confirmation Message to Create Accounts window will open.
Click OK to add this account, or click Cancel if you do not want to add this record to your CRM.

Employee Respo... |0000000650 Employee Name:
Account role Account

This action will create 1 account record in your CRM.

Do you wish to continue?

oK. CAMCEL

Creating a New Account Using Name and Address

You can run a search using a name and address, then create an account based on the search results.

1. From the D&B360 menu, click Accounts with D&B360.

el s =~
e[ ~" Click Accounts
Accounts With with D&B360.

D&B360 L J

2. (Required) In the Company Name field, type the company name.
3. (Required) In the Country and State/Province fields, use the menu to select the correct information.
4. (Optional) In the City, Address, Phone, and Postal Code fields, type this information if you have it.

5. Click Search to display a list of candidates based on your search criteria.

©Dun & Bradstreet, Inc. 2014 3-2
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[ s
_.f"_ . -,
{529/ \e2) | 4l hittps://dnbde... L~-acdx :!Dﬂ"h"a"' i DBB3... *
% S
File Edit View Fauuri‘tF': Tools  Heln .
Account S¢ Type Company Name — include About DEB3I6D
b DEB Account Lo iantens
D& B350
Company Mame * Dell Country = United State
City State/Province * Texas -
Address Postal Code
Phone
Click Search.
L &

6. Select the appropriate row and click Create Account to select the company that best matches your
search criteria.

About D&B360
Account Search About BResed

) D&B Account Search

a‘.-.:d
D&B360
Company Mame * Dell Country * us 4
City Round Rock State/Province * X -
Address 1 Dell Way Pastal Code
Phone

‘&_ = Existing Account & = Existing Contact A = Existing Lead

Match Info Company Address City State/Pro Country Postal Code Phone -]
o & A\ DELLINC 1 DELL WAY ROUND ROCK T us 78682-7000 (512) 338-4400
DELLINC 1 DELL WAY ROUND ROCK  TX us 78682-7000

""" 00EE DELLINC 1 DELL WAY ROUND ROCK  TX us 786E2-7000 (BY7) 717-3355

""" 1781 DELLINC 1 DELL WAY ROUND ROCK T us 78682-7000

""" 7503 DELLINC 1 DELL WAY ROUND ROCK  TX us 78682-7000 (512) 338-4400

< I| click Create 2
1-50f5 |« 4| Account f1 »

| Create Lead | | Create Account |

If you want to review the match information before you make a decision, do not click Create. Instead,
see the following steps.
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A gold star displays next to the first record and represents the Best Match found based on your

search criteria. The more details you provide, the better the results.

Review the match information before you make a decision, complete these steps:

1. Next to the match candidate that you selected, click

Match Info.

The D&B Match information provides additional insight into how that D-U-N-S Number was matched

to the company entered.

" Account Search
|‘._‘§ D&B Account Search
D&B360

Company Name * Cell
City
Address

Phone

A = Existing Account & = Existing Contact A = Existing Lead

Match Info Company Address

A A 1 DELL WAY

5015 WESTHEIMER RD #
8200 N MO PAC EXPY STI
805 CASHEW LN

950 LOMA VERDE DR
701 E PARMER LN

1 DELL WAY

1 DELL WAY

133018 MCCALLEN PASS

2. Review the match information.

3. If you want to add this account, click Add.

©Dun & Bradstreet, Inc. 2014

Country * us
State/Province * X
Postal Code
il

City

ROUND ROCK

K120 HOUSTON

E 185 AUSTIN
CEDAR PARK
DALLAS
DALLAS
EL PASO
AUSTIN
ROUND ROCK
ROUND ROCK
AUSTIN
DALLAS

State/Province

A EHE IR A

Country
us
us
us
us
us
us
us
us
us
us
us
us

About D&B360

Postal Code
TE682-T000
77056

T8759-8865
78613-3209
7538%-0001
75312-0001
79936-7899
78753-3520
78682-7000
TEG82-T000
TET753-5303

75267

L]
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D&B Match Info 3

D-U-N-§: *===*=5955

Confidence Code (10-1): -6

You Entered D&B Matched

Dell DELL INC.

1 DELL WAY
TX ROUND ROCK, TX 78682-7000
us us

D&B MatchGrade

E Exact Company Mame match.

Mo Street Mumber data entered in search. Adding info could improve the search.
Mo Street Mame data entered in search. Adding info could improve the search.
Mo City data entered in search. Adding info could improve the search.

E Exact State/Province match.

Mo Phone Mumber data entered in search. Adding info could improve the search.

D&B Match Profile
Matched to the Primary Business name

Entered data matched to the Current physical address

b "

ar click OK.
g W

—OR -

To close the window without adding this account, click OK.

Creating a D&B360 Account Based on a List of Criteria

You can create an account by building a list of the available options that you locate using unique and specific
search criteria:

1. From the D&B360 tab, click Build-A-List.

Build A
List

D&E Build A List

©Dun & Bradstreet, Inc. 2014 3-5
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Several categories of information display, each of which provides specific criteria that you can select for

your search.

2. Enter the search criteria.

3. Inthe Company Results area, click Company Search.

m Build A List
DB]

D8B350
Search | Puopis Refulls | Compaey Results

Saved Search - Mone - w  |Swee Curment Seacch
» People (Bic and Title Keyword, Job Title)

= Company lecation (Country, US State/CAMN Province, City and more)

Aot DERBED

Most Recent Search =

Comamiry ol United States U5 Stabe/CAN Province Seuth Carciing U5 Metronai Tan Anes 10160 « Abilene *
Amania | Sousn Daicota 10380 - Aguad
Ageris Tennesses 10430 < Alron
; ; ) Teas . s
Giobal Suane/Froninge Chy Io/Poral Cood
— -
kam lgrpaddaal |

L™ emtitimensea)

4. Next to the account that you want to use for your search, click to select the check box.

5. To create the new account, click Create.

6. To export company results to an Excel spreadsheet on your local directory, click the Excel icon.

©Dun & Bradstreet, Inc. 2014
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Build A List

DEE360
Search | People Results | Company Results

Saved Search Save Current Search

& = Existing Account & = Bxisting Contact /A = Existing Lead

| Company | mddress
1 Dell Way

1 Dell Way

13200 Pond Springs Rd A102
8900 Shoal Creek: Blvd.

8619 Wall 5t

3306 Clawson Rd

1 Dell Way

8210 Asmara Dr

141 Park Place Dr

3301 Hibbetts Rd

9514 Mcneil Rd Ste 102

|| Create Account || Create Lead | O-U-K-5
] [l s g3
[} [ wERRZART
[} [ HRTRAG
[} [ i 11211
[ O wwrEngAE0
] Ol weeeA352
[} [ i 5
[} [ w110
[} [ HEERE LD
L ] weReeBADE
[ O w3142
1
1 - 41 of 41 (1 selected)

About D&EB360

Click to export to
Excel spreadsheet

| city |
Round Rock

Round Rock
Austin
Austin
Austin
Austin
Round Rock
Austin
Geargetown
Austin
Austin

I4 4 Page 1

Click Create. Create

f\;

State/Proy g

™
™
™
™
™

=
I=

==L =R~ R

s

3

ofl b

For more information about specific category details, See "Using Build a List" on page 7-1 . You will not use

the People section for company searches.

Note: A yellow status indicator displays when an account is being created. A green status
indicator displays when the account is created.

Criteria Categories

You can run a search based on criteria in one or more categories, which expand when you first select them

(not shown in previous illustration).

For specific information that you can enter within each of these categories, see "Using Build a List" on page 7-

1.

Links to this specific category details section are provided below to identify the information collected for:

Company location

o Company size (and more size criteria)

e Industry
o Company type

Financial data

©Dun & Bradstreet, Inc. 2014
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e Key numbers
e USIPO data

e Special criteria

Creating a D&B360 Account Based on Attributes of a Specific
Account

You can create a list of companies that share the attributes of an existing account. You can then choose an
account from that list and create a new account.

1. From the D&B360 menu, click Accounts with D&B360, or from the left menu, select Customers ->

Accounts.
Dashboards D&EB360 4 Customers

1
¢ Accounts Customers ->

85 Contacts Accounts.

2. Inthe list that displays, click to select an account.
The Account Details window for that account opens.
3. To open Build-A-List with account detail information for that account, click D&B Look-A-Like.

E’.g Click D&B
D&k

- Look-A-Like.
Look-A-Like

4. In the Build-A-List window, click Company Search.

Note: Attributes of the original account you selected will populate the search fields. To obtain
better search results, we recommend that you examine, alter, or add criteria information.

©Dun & Bradstreet, Inc. 2014 3-8
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Aot B3N

E Build A List
Ay

DEBIE0
Search | Pyopie Resulls | Compaey Resulls

Saved Seaeh - More - = hicst Recent Saperh *
» People (Bio and Title Keyword, Job Title)

= Company lecation (Country, US State/CAN Province, City and more)

Cownry 1 United States. = VS SteiCAN Provinee ||| geush Carciing | = US MattropolRen Ared ||| 10150 . Abiters =
Ll Amaniy | IS Scuth Daimes L LD3BD - Apuadi
L Augeris 3 I Tennesses ] L 20820 - Adoron L
4 " _' 1] Texas - ] * _l

Ciy

5. Click to select the check box for the account that is similar to your original one.

6. Click Create.

File Edit View Favorites Tools Help
. . About D&EB380
Build A List SReE et
| D
D& B360
| Search | People Results | Company Resuits |
Saved Search Save Current Search
_,ﬁ. = Bxisting Account & = Existing Contact {_{_\_\‘ = Existing Lead faa
[_] create Account [ ] Create Lead | D-U-N-5 | Company & Address | City | state/Province | Courg
|:| weRer2532 Hewilett-Packard Company 3000 Hanover 5t Falo Alta  CA us
4| | 3
1-10f 1 (0 selected) 14 4 Page 1 of1 b
Click Create. Create

The new account is created.

Note: A yellow status indicator displays when an account is being created. A green status
indicator displays when the account is created.
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Creating a D&B360 Account from Records Related to Existing
Accounts

You can create a new account by identifying Family Tree accounts or other existing accounts and using them

as the basis for your search.

1. From the D&B360 menu, click Accounts, or from the left menu, select Customers - > Accounts.
4 Customers

._} Accounts

85 Contacts

2. From the list that displays, click to select an account that you want to pursue.

The Account Details window for that account opens.

3. Todisplay the Related Accounts window, click D&B360 View.

.I'_.-'I\"'-:‘ i
D&EIE0 Click D&B360
View View.

4. To enter family tree information, click Family Tree Query or Family Tree Hierarchy.

. About DEB360
" D&B360 View Click Family Tree Query or E—
325 Dell Inc. Family Tree Hierarchy.
DEE360

Related Accounts | Family Tree Query | Family Tree Hierarchy

Search for related family members in the full Family Tree. Import companies as Accounts.
Ultimate Name Dell Inc.

Account Name Dell Inc.
imate D-U-N-5 114315195

D-U-N-5 114315195

Tree Levels i 7
Location ‘i’ |+ Country of Global Ultimate [+ Other Countries Type i/

Note: The Family Tree Hierarchy provides the same information as the Family Tree Query in a
graphical display based on corporate family relationships.

|+ Subsidiaries | | Branch

©Dun & Bradstreet, Inc. 2014 3-10
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5. After you select the Family Tree Query or Family Tree Hierarchy tab, you can filter your search as

follows:

a.

b.

In the Tree Levels field, select the number of levels for your search, from 1 to 26.

Select the Country of Global Ultimate check box to search for the top, most important, responsible
entity within the corporate family tree.

Select the Other Countries check box to search for related family members in other countries. This
search will include the country of the Global Ultimate DUNS. If you leave it unselected, only those
companies in countries outside of the Global Duns Country display. If you select only this check box,
only companies that exist in the same country as the Global Ultimate DUNS display.

To receive all records, leave both selected.

Select the Subsidiaries check box to search for a corporation that is more than 50% owned by the
parent company, but has a different legal business name from its parent company.

Select the Branch check box to search for any secondary locations of a company's
headquarters.Branches have no legal responsibility for the parent company's debts, even though bills
may be paid from the branch location.

6. Make sure the filtering criteria you selected is what you want, and then click Search.

%‘% D&B360 View About D&B3E0
.A

A:  Dell Inc.
D& B360

Related Accounts | Family Tree Query | Family Tree Hierarchy

Search for related family members in the full Family Tree. Import companies as Accounts.

Account Name Dell Inc. Global Ultimate Name Dell Inc.
D-U-N-S 114315195 obal Ultimate D-U-N-S 114315195
Tree Levels i/ 7 -
Location i/ |+ Country of Global Ultimate |+ Other Countries Type i/ |+ Subsidiaries | | Branches

& = Existing Account & = Existing Contact & = Existing Lead

|| Create Account || Create Lead D-U-N-5 Company City Stat Country Location Status -

=

|} waraf195 ‘r& ROUMDRC TX us -
| [ w4492 AUSTIM ™ us ParentSubsidiary
[} [} FAERG002 SKOKIE 1L us ParentSubsidiary
[} [} FHEALN20 ROUNMDRC TX us ParentSubsidiary
1+ L} wee3827 SAN JOSE CA us ParentSubsidiary
R =i ROUNDRC TX us P tSubsidiary
o o Also Trades as: [DELL COMPUTE arenubsiciany

-

1 - 50 of 77 (1 selected) Page 1 of 2 »
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7. To identify the accounts you want to create, select the corresponding check boxes. If the record is

already in your database as an account, the yellow account icon A will display next to that account.

8. Click Create, and then wait until the status indicator displays in green.

Note: A yellow status indicator displays when an account is being created. A green status
indicator displays when the account is created.

Reviewing Results when Searching by Family Tree Hierarchy

You can use Family Tree Hierarchy tab to run a search similar to the Family Tree Query. However, the results
for a Family Tree Hierarchy search display in a tree structure.

You will still be able to filter the list on Country or Global Ultimate, or Other Countries by clearing the check
marks. To receive all records, leave both selected.

You can also filter on Subsidiaries only or add in Branch records and choose how many levels of the tree you
want to receive from the Global Ultimate.

9. Complete these steps to search by Family Tree Hierarchy:

10. Make sure you have selected the filtering criteria that you want to filter on.

11. Click Search.

12. To identify the accounts that you want to create, click the corresponding check boxes.

If a search result record is already in your database as an account, the duplicate account icon — a A

yellow triangle — will display next to that account.

Creating a D&B360 Account from Competitors

Use this feature to identify the competitors to your accounts and then add them to your CRM for nurturing.
You can also create leads from competitors. For more information, see "Creating a Lead from a Competitor”

on page 6-14.

1. From the left menu, select Customers -> Accounts.

4 Customers

) Account Select
[ Accounts T —
8= Contacts Accounts.

2. Inthe list that displays, click to select an account.

The Account Details window for that account opens.

©Dun & Bradstreet, Inc. 2014 3-12
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3. Todisplay a list of competitors, click D&B Competitors.
The Competitors List for that account displays.

Competitors List About D&B360
Competitors for Dell Inc.

Ao |
B360
Matching Companies: 28

1 Records Selected
A = Existing Account & = Existing Contact ‘AA = Existing Lead

|| Create Account || Create Lead | | D-U-N-5 | Company Name | City | State/Prov | Country | Annual Sales | Is Top Competitor| &
1L L [ﬁ] s 980 Curitibe ~ Parana Brazil $1,114.95 o
1] L § eeearos Hong Kong  $28,57444 @ il
[ L Eﬁl FEERg493 Moida Uttar Pradesl  India $2,408.32 3
2
L]

lCI' k Create. :b-
e Create

4. To add a company to your accounts list, select the corresponding box under the Account tab.

5. Click Create.

©Dun & Bradstreet, Inc. 2014 3-13
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With D&B360 you can leverage D&B data to enrich your account information. In addition you can use
information from public sources to verify or enrich your account information.

LeVeraging RO . 4-2
Adding D&B Data to an Existing AcCoUNt L. . 4-2
Identifying Related Accounts in D&B . . . . 4-4
Finding Industry Information about Existing Accounts ... ... 4-5

Adding Industry Information to an Existing Account .. ... .. 4-6

Leveraging Industry Information . . 4-8
Adding Financial Information to Existing Accounts ... . . 4-10

Note the following:

A gold star displays next to the first record and represents the Best Match found based on
your search criteria. The more details you provide, the better the results.

A A yellow triangle with the letter A indicates an existing account.
A\ A yellow triangle with the letter Cindicates an existing contact.

A A yellow triangle with the letter L or Oindicates an existing lead or opportunity.

Note: When you click or select the name of a company, a Company Overview window opens that
displays details about that company including D-U-N-S number, name, location, address, a synopsis, and
more.

©Dun & Bradstreet, Inc. 2013-2014 4-1
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After you create or add a new account, the Confirmation Message to Create Accounts window will open.
Click OK to add this account, or click Cancel if you do not want to add this record to your CRM.

Employee Respo... |0000000650 Employee Name:

Account role Account

This action will create 1 account record in your CRM.

Do you wish to continue?

oK. CAMCEL

Leveraging ROW

You can use Rest of World (ROW) as an information source for news about a company and link to news
stories directly from the windows where you are working. For more information, see "Leveraging ROW" on

page 4-2.

Adding D&B Data to an Existing Account

D&B data is comprehensive and detailed. If you have an existing account with incomplete information, the

quickest way to enhance it is to add D&B Data.

1. From the left menu, select Customers - > Accounts.

4 Customers

3 " Select
& Accounts P
8 Contacts Accounts.

2. Inthe list that displays, click to select an account.

The Account Details window for that account opens.

Account

Microsoft

Primary Contact Preferred Method of Contact
Any

Credit Limit Annual Revenue

3. To add D&B data to that account, select D&B Data -> Add.

©Dun & Bradstreet, Inc. 2014
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4. Inthe Account Search window, identify the company you want to add D&B Data too, then click Select.

About D&B360
Account Search 200 UaBast
D&B Account Search

0
Company Mame * Microsoft Country * us hd
City Palo Alto State/Province * CA -
Address Postal Code 94306
Phane
Sear
& = Existing Account & = Existing Contact A = Existing Lead
Matchinfo | Company Address | city | State/Prov | Country | Postal Code | Phone o
380 PORTAGE AVE PALO ALTO A us 04306-2244 (650) 693-3521
2840 EMERSOM 5T PALO ALTO A us 84306-2350 (B50) 693-3363
4| | 2
1-2¢of2 |4 4 Page 1 of 1 »

5. Inthe Add D&B Data window, identify which data you want to use to update the account and clear any

data you do not want to include.

6. Review each new value to identify which data you want to use, then click to select it for the update.

7. To update your account with the selected D&B data, click OK.

©Dun & Bradstreet, Inc. 2014 4-3



D&B360 User Guide 4 Enriching Accounts with D&B360

" Add D&B Data 5
Add D&B Data About D&B360
371 Choose data to migrate into the account.
D&B360
Field | CRM Data | D&s Data | override value |
Account Name L Microsoft \*) Microsoft Corp L4 | |
Account Description L= \2) Monclassifiable establish '/ |
Mumber of Employees ‘2o [i] L |
Address 1: Street 1 L= \2) 380 Portage Ave e |
Address 1: City L= \2) Palo Alto e |
Address 1: State/Province ‘= Washington &ooa e |
Address 1: ZIP/Postal Code ) \2) 94306-2244 L= |
Address 1: Country/Regicn & & us &) |
Address 1: Phone L W2 [B50) 693-3521 N |
Address 2: Street 1 o) L |
Address 2: City =) | |
Address 2: State/Province o) L |
Address 2: ZIF/Postal Code o) L |
Address 2: Country/Region et L= |
Revenue b &0 W |
SIC © *) 9999 J |
T——— ——

Identifying Related Accounts in D&B

1. From the left menu, select Customers - > Accounts.

4 Customers

Iﬂ_:}' A " Select
ccounts Customers -
|83 Contacts Accounts

2. From the list that displays, click to select an account. The Account Details window for that account
opens.

3. To open the Related Accounts window for that account, click D&B360 View.

©Dun & Bradstreet, Inc. 2014 4-4



D&B360 User Guide 4 Enriching Accounts with D&B360

44 Microsaft Dynamics CRM

Account Add Customize DE&EB360
I

Save  Save & D&B D&B D&B3e0+- D&B  |D&B360 D& DE&EB D&B DE&B

Click D&B360

Close }( Data ~ Refresh Contacts | View  Look-A-Like Competitors Industry Financials
Save DéB360

4. Enter your search criteria, and click Search.

D&B3060 View About D&B360

A Dell Inc.
DE&B360

Related Accounts | Family Tree Query | Family Tree Hierarchy

The page provides a view into your accounts that are related through legal corporate ownership. &ll of the companies have the same
global ultimate record. If you would like to see the full family tree, including the members not currently a part of your account list, go to
the Family Tree Query tab.

Global Ultimate Name Dell Inc.

Global Ultimate D-U-N-S 114315195
D-U-N-5 | Account Name | State | Active Opportunities | Closed Opportunities | Account Owner | Risk Level* &
114315195  Dell Inc. LS 0 0 Product Team O -
114315195  Dell Ing Texas 0 0 Small Business 2 a
619151033  Dell Inc. California © 0 Product Team a
114544901  Dell Corporation Tllinois 0 0 Small Business 2 P
114315195  Dell Ing Texas 0 0 Product Team 0
114315195  Dell Inc. Texas 0 0 Sales Engineer 1 a
1214582657  ASAP Software Express Inc,  Illinois 0 0 Product Team 0
152145046  Dell Inc. Teuas 0 0 Hoowvers Team 0
114315195 DellInc. Texas 0 0 Product Teamn "‘ 3
* pvailable on US based companies only.

Note: To become more familiar with the data, find a specific related account, or to prepare to add one of
the listed accounts as a new account, review the data in this window. Green, yellow, and red icons next to
an account indicate its risk level. For more information, see "ldentifying D&B360 Standard Options and
Icons" on page 2-7.

Finding Industry Information about Existing Accounts

Industry Information powered by First Research is valuable tool that can help you prepare for a sales call or
customize a marketing message. By gaining perspective on a specific industry’s business challenges and
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opportunities, you can quickly gain important knowledge and insight. Each D&B360 account is mapped to
related industries through their SIC code.

1. On the left menu, select Customers -> Accounts.

4 Customers

Y Select
L‘f ccounts T
8= Contacts Accounts.

2. Inthe list that displays, click to select an account.
The Account Details window for that account opens.

3. Click D&B Industry.

Al Microsoft Dynamics CRM
File Account Add Customize D&EB360
|

HESHE S BE B B,

Save Save & DEE D&E D&B3ED+- D&E DEE3GD D&E D&E D&E D&E
Close )( Data » Refresh Contacts  View Look-A-Like Competitors Industry Financials
Save DE&B360
Click D&B

Information [ Account Industry.

General - "~ Dell Inc.
R

L L Primary Contact Preferred Method of Contact
D&E360 Any
Nataile

The D&B Industry window for the account opens and displays a list of the account's related industries.

If you don't see a related industry you believe should be included, you can add it (see "Adding Industry
Information to an Existing Account" on page 4-6).

For more details about how to use this information, see "Leveraging Industry Information" on page 4-8.

Adding Industry Information to an Existing Account

If you don't see the type of industry you are interested in already associated with the account, you can add an
industry association.

1. Click Add Industry.

©Dun & Bradstreet, Inc. 2014 4-6



D&B360 User Guide

4 Enriching Accounts with D&B360

D& EB360

Add Industry
Industry Code | | Industry Detail
10499 Computer Peripheral Equipme
1100 - Device & Spe
110 - er Display & Projecto
1103 g & Imaging Eg =
1105 ersonal Computer Manufacty
1106 Server & e Manufact
1119 ation Technology Se
111 Computer So =
1843 - ber

Add Industry

D&B Industry - Dell Inc.

powered by First Research

About DEE360 *

Back to Account

[ ]

Click Add
Industry.

2. Inthe D&B Industry Search window, you can enter a keyword to search on and click Keyword, or you
can search by SIC, or NAICS.

3. Click Search.

D& B 360

| routers

D&B Industry Search

powered by First Research

Search for SIC or NAICS code

About DRB3EG0

Back to D&B Industry

Search by: Keyword (*) SIC () MNAICS (_) Search

Click Search.

4. Next to the industries that you want to associate with this account, click to select the corresponding

boxes.

©Dun & Bradstreet, Inc.
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] 1584
] 1577
] 1904

! 1099
L] 1980

Internet access and related services.
voice, data, and video communications services.

content on the Internet or operate search engine Web sites.
Companies in this industry design and manufacture mice and other input devices, displays and
projectors, and printing and imaging equipment. The industry also includes companies that design

and manufacture automated teller machines (ATMs), point-of-sale [POS) systemns, and other
computer peripheral devices.,

storage batteries.

to it.

Note: If an industry is already associated with this account, a yellow warning sign displays next

If you decide to remove an industry that you manually added to an account, click the trash can icon

next to the industry code.

Leveraging Industry Information

D&B Industry Information from First Research provides Sales and Marketing users with deeper insight about
industry drivers and how these might affect a company. The information available includes:

e Business challenges

o Call preparation q
o Executive insight

uestions

e Glossary of acronyms
e Industry indicators

e Industry overview
¢ Industry web sites

e Trends and opportunities

©Dun & Bradstreet, Inc. 2014
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D&B Industry Detail About D&E360  ~
07:] powered by First Research
D&B360
Computer Peripheral Equipment Manufacturing Back to DAE Incustry
Description
Business Challenges

- - Clicka
Call Preparation Questions < categoryto
Executive Insight \_expendit.

Glossary of Acronyms

Industry Indicators

Industry Overview

Industry Websites

Quarterly Industry Update

Trends and Opportunities |

The following illustration shows the types of industry details that display.

D&B Industry Detail About D&B360  ~
37 powered by First Research
D&B360
Ccomputer Peripheral Equipment Manufacturing Back to D&B Industry
Description
Business Challenges

Call Preparation Questions

Call Preparation Questions - Conversation Starters
How do changes in technology impact the company?

The industry i1s charactenzed by rapid shifts in technology.

What are the key drivers of demand for the company's products?

The industry is dependent on the health of the overall economy because demand is driven by business ¢
and sales to computer manufacturers,

What adjustments has the company had to make to compensate for declining use of ¢

The industry has traditionally relied on supplying penpherals for use with desktop PCs.

Which new markets does the company feel are best suited for potential revenue grow

Companies with an international presence are increasingly targeting what they consider "underdevelope

©Dun & Bradstreet, Inc. 2014 4-9
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Adding Financial Information to Existing Accounts

1. From the left menu, select Customers - > Accounts.

4 Customers

I__.-_} A " Select
: ccounts T
8= Contacts Accounts.

2. Inthe list that displays, click to select an account. The Account Details window for that account opens.

3. To open the D&B Financials window for this account, click D&B Financials.

Account Add Customize D&EB360
% | 3 "
H lﬁ sl E; EQ' Eﬁ-} Eﬁﬂ E%] E b e

4] Microsoft Dynamics CRM

Save  Save & DB D&EB D&B360D=- D&EB  D&EB360 DEb D&E D&E D&E
Close )( Data ~ Refresh Contads VWiew Look-A-Like Competitors Industry Financials

Save D&EBE360

Click D&B

Information Account Financials.
-
General - Dell Inc.
otes & Adtivities Primary Contact Preferred Method of Contact
DEEB360 F'Lr'l}"
Matails

Note: The amount of financial data available varies by company.

If this is the first time you are adding financial information to an account, the Financials window will
have a link labeled Add Information. After you've added financial information to an account, the link is
labeled Import Information from D&B360, as shown in the following illustration.
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. . About D&B360
Financials ADOUL Uebans

D Financials for Dell Inc.

e

D&B360
Refresh Information from D&B3I60 Information from Back to Account

Annual Income Statements
Basic Financial Information
Current Information
Financial

Growth

Growth Rates

Operations

Per Share Data

Profitability

Top Competitors

Valuation

4. To drill farther down into the available information, click any of the categories that are listed in this
window.
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5.

Financials
[ &

ol

D&B360

Financials for Dell Inc.

Refresh Information from D&B350
Click to expand &

category.

Basic Financial Information
Current Information
Financial

Growth

Growth Rates

Operations

Per Share Data
Profitability

Top Competitors

Valuation

|.F|.nnnal Income Statements ‘d”L

Annual Income 2012 2011 2010
Statements

Diluted Eps 1.88 1.35 0.73
Gross Profit $13,811.00M $11,395.00M £9,261.00M
Operating Income $£4,431.00M $3,433.00M £2,172.00M
Revenue $62,071.00M $61,494.00M $52,902.00M
Total Met Income $3,492.00M $2,635.00M $1,433.00M

About DEB360

Back to Account

Clickto view the
data graphically.

ad
\ad
\d
\d
\d

To view the data visually, click the chart icon.

©Dun & Bradstreet, Inc. 2014
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A chart that includes the relevant data opens, as shown in the following illustration:

70000 P o042

0000 M 2041

P 2010
50000
40000
20000

20000

10000

Revenue
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5 Adding Contacts with D&B360

With D&B360 you can leverage D&B data to enrich or add to your contact information. You can also use
information from public sources to verify or enrich your contact information. You can add contacts to existing
accounts and create leads/opportunities for new account opportunities, both of which are ways to enrich
already established accounts.

PersON Biographies .. 5-2
LeVeraging RO . 5-2
Adding a Contact from an Account Record . ... . . o i 5-3
Adding a Contact from D&B360 Directly ... ... .. 5-4
Adding a Contact Using Build-A-List ... L 5-7
Merging CoNtacts o . e 5-9

Note the following:

A gold star displays next to the first record and represents the Best Match found based on
your search criteria. The more details you provide, the better the results.

/R, Avyellow triangle with the letter A indicates an existing account.
A\ A yellow triangle with the letter Cindicates an existing contact.

A\ Ayellow triangle with the letter L or O indicates an existing lead or opportunity.

Note: When you click or select the name of a company, a Company Overview window opens that
displays details about that company including D-U-N-S number, name, location, address, a synopsis, and
more.
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After you create or add a new contact, the Confirmation Message to Create Contacts window will open.
Click OK to add this contact, or click Cancel if you do not want to add this record to your CRM.

Employee Responsible 000000650 Employee Name: John Brown
Account role Account - Contact role Contact Person -

You have 123,456,768 of available records out of your limit of 123,456,789 total allowed standard contact records.
You have 4,498 of available records out of your limit of 4,512 total allowed premium contact records.
This action will create 1 contact in your CEM.

Do you wish to continue?

0K CAMNCEL

Person Biographies

To display information about a contact, from a list of contacts, click the contact's name. The D&B360 Person
Biography window opens and includes some or all of this information about that contact:

o Current employment including job title and name, address, and phone numbers of employer

Employment profile

Previous employment

Employment history

o Compensation history

Leveraging ROW

You can use Rest of World (ROW) as an information source for news about a company and link to news
stories directly from the windows where you are working. For more information, see "Leveraging ROW" on

page 5-2.

The D&B360 menu options and icon links display and remain on the menu as you navigate through the CRM.
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Adding a Contact from an Account Record

1. From the left menu, select Customers -> Accounts.

4 Customers

Y Select
|__,- ccounts T
8= Contacts Accounts.

2. From the list that displays, click to select an account.
The Account Details window for that account opens.

3. Todisplay a list of potential contacts, click Contacts with D&B.

Al Microsoft Dynamics CRM

Account Add Customize D& B30
|

HSHE R

Click D&B

Save Save & D& D&E D&EBE360+  D&B D&E D& D&E
Close }( Data » Refresh Contacts Contact=. Competitors Industry Financials
Save
Information Account
-
f General - Amazon.com, Inc.

The D&B Contact Search window opens.
4. Next to any contacts you want to add, click to select the check box.

5. To add the selected contacts, click Create.

Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the
records you selected.
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" Contact Search

[ D&B Contact Search

A'.;.:d
D&B360

Search by Contact Name Search by Company Info

About DRB360

Conttact Name D-U-N-5 072443680 Job Title [ acquisitions =
Company Name Amazon Co Lid | Administration -
|| Business Develo| 3
K ords
o < ] v |
‘& = Existing Account & = Existing Contact A = Existing Lead
|#] Create Contact Merge || Create Lead Full Name Company Name Title Contact Details E
ol President Mame & Title
e Clicktoselect j =
contact
1| | 3
1 -1 of 1(1 selected) |4 4 Page 1 of 1 »
Click Create. Create

click OK. If you decide not to use your contact credit for that contact, click Cancel.

Note: When you click Create to create a new contact, the People Credit Information
window opens to inform you of your current contact credits. To add the new contact,

People Credit Information

You have 48 available out of 50 contact credits.

Do you wish to continue?

oK cCancel |

Adding a Contact from D&B360 Directly

¢ From the D&B360 tab, click Contacts with D&B360.

Option #1: To contact candidates from a specific company, search Company Information.

1. Inthe Company Name field, type the name of the company for your search criteria.
2. Select any Job Titles that you want to include.
3. Click Search.

©Dun & Bradstreet, Inc. 2014
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Contact Search
D&B Contact Search

! d
D&B360
Search by Contact Name

Contact Mame

click Create.

Contact Search
D&B Contact Search

D&B360
Search by Contact Name

Contact Name

D-U-N-5

Company Mame

Search by Company Info
884745530

Amazon

Keywords

Job Title

—

4. Inthe Create Contact column, select the check box next to the contact you want to create, and then

Search by Company Info

D-U-MN-5
Company Name Amazon

Keywords

A = Existing Account & = Existing Contact A = Existing Lead

|| Create Contact | Merge | || Create Lead
L] e Ll
|«] < Clicktoselect ¥4 L]
O contact 2 0
LJ d Ll
[ s [

1]

| Full Name

| Company Name

About D&B360

| acquisition: *
| Administrat —|
[v| Business Dy 3

| 4

About D&B360

Job Title | Acquisitions =
L Administration —|

|| Business Developme 3
(A | 4 |

| Title | Contact Details @
Kepvizelo tag Name & Title |+
Chief Finance Officer Title —|

Director Genera

Proprietor

1 - 50 of 3679 (1 selected)

Title
Title E
3
|4 4 Page 1 of 74 »

Click Create.

records you selected.

Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the

©Dun & Bradstreet, Inc. 2014
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Note: When you click Create to create a new contact, the People Credit Information
window opens to inform you of your current contact credits. To add the new contact,
click OK. If you decide not to use your contact credit for that contact, click Cancel.

People Credit Information

You have 48 available out of 50 contact credits.

Do you wish to continue?

ok [| cancel |

Option #2: To search for the name of an individual within a company, search Contact Name.
1. Inthe Contact Name field, type the contact name for your search criteria.

2. Torun the search and display a list of possible contact, below the Search by Contact Name area, click
Search.

%"% Contact Search About D&B360
.A-

At D&B Contact Search
D&B360
Search by Contact Name Search by Company Info
Contact Name John T Chambers D-U-N-5 Job Title | Acquisitions -
EE e | Administration -|
|| Business Development L

Keywords . ] N J

Click Search.

3. To choose which contacts you want to create from this list, click to select the corresponding check boxes.

4. To associate the contacts with this company, click Create.
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A = Existing Account & = Existing Contact A = Existing Lead

|| Create Contact

Clicktoselect
contact

D O0ROODDooODC

L

Merge

CDHNERNSNCNNNSNS

|| Create Lead Full Name Company Mame

(0 o o o o o

1- 25 of 25 (1 selected)

Title Contact Details =)
Pres &t Treas Mame & Title =
Prin Mame & Title
President Mame & Title 8 Email
Managing Director,Director  Mame & Title
Company Secretary Mame & Title
Director Mame & Title
Company Secretary Mame & Title
Chairman and CEQ Mame & Title
Director Mame & Title
Principa Mame & Title
Partner, Mergers and Acqui  Name & Title o
| 3
I4 4 Page 1 of 1 p
Click Create.

Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the
records you selected.

Note: A yellow status indicator displays when an account is being created. A green status
indicator displays when the account is created.

Adding a Contact Using Build-A-List

From the D&B360 menu, click D&B360 Build A List.

1.

2.

3.

Build A

List
D&E Build A List

In the D&B360 Build A List window, People (Bio and Title Keyword, Job Title) area, enter your search

criteria.

To display a list of candidates, click People Search.

©Dun & Bradstreet, Inc. 2014
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w |Sawve Current Search

~ People (Bio and Title Keyword, Job Title)

Keyword(s) in

e.g. marketing or Harvard or ad sales.

Country @ United State * US State/CAN Province
[ albania
D Algeria
—
4
Global State/Province City

e.g. Queensland or MY.
Multiple entries should
be separated by a

comma with no spaces.

US/CAM Area Code Area Around US Zip Code

e.g. 512, Multiple
entries should be
separated by a comma
with no spaces.

. R About D&E3ED
Build A List =
LA
DE&B360
Search | People Results | Company Results |
Saved Search  -- None -- Most Recent Search

| (=) Title (_) Bio

~ Company location (Country, US State/CAN Province, City and more)

JobTitle |[] Acquisitions =
[ agministration
D Business Development
¥l ceo 3
[ alabama US Metropalitan Area | [ ] 19950 ayn *

[ alaska
D Arizana
D Arkansas

[] 12260- Aug

@ 12420 - Aus
— -

3

Zip/Postal Code

e.9. Madrid or Mew
York. Multiple entries
should be separated by

e.g. 78701 or SW1P 1IA
or SW1. Multiple entries
should be separated by

a comma with no
spaces.

a comma with no
spaces.

Miles = of Zip Code

&.g. Find results within a 50 mile radius of a Postal Code (up to a maximum
radius of 100 miles or 160 km). Use only one 5-digit ZIP code.

[ o r

Click People
| Search. J’> | People Search | |Company Search|

4. Inthe Build A List window, People Results list, select the contact you want to add , then click Create.
E Build A List About DXE360
D&R
D&BE360
Search | People Results | Company Results |
s s
‘_fﬁ_\. = Bxisting Account & = Existing Contact /_i_‘}. = Existing Lead
[[] Create Contact | [ Createlead | Full Name = | Company Mame | Title | Contact Details z-|
¥ Clicktoselect L] Roger Acord Heb Prin Name & Title
|:| contact D Herbert Acord Cypress Greek Holdings Lid Prin MName & Title
] ] resa Acosta Ifren Tees Prin Mame & Title
[ [ Zachary Acosta Zachary C Acosta Sr Prin Mame & Title E
(4] | 3
201 - 250 of 84765 (1 selected) I4 4 Page 5 of 1696 F

©Dun & Bradstreet, Inc. 2014
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Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the
records you selected.

Note: When you click Create to create a new contact, the People Credit Information
window opens to inform you of your current contact credits. To add the new contact,
click OK. If you decide not to use your contact credit for that contact, click Cancel.

People Credit Information

You have 48 available out of 50 contact credits.

Do you wish to continue?

(s [| cancel |

Note: A yellow status indicator displays when an account is being created. A green status
indicator displays when the account is created.

Merging Contacts

You can use the merge function when you have contact information in your CRM that did not come from
D&B. In some cases, you might have more information because of the working relationship you have with
this contact. However, in many cases the D&B information might be more current. To review information
from both sources and determine what information you want to retain after the merge, use the merge
duplicated contacts feature.

1. Todisplay a list of your accounts, select Customers -> Accounts.
2. Click an account to select it. The Account Detail window for that account opens.

3. Click D&B Contacts.
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41 Microsoft Dynamics CRM
Account Add Customize DEB360
H: BEEEEE 5
Save  Save & D&E D&B  D&EBE3&0+  D&EB DE&B380 D&E D&E D&B D&E
Close )( Data ~ Refresh Contacts  View Look-A-Like Competitors Industry Financials
—— " Cickpas |
Contacts.
Information Account
Record Wall o | .- Microsoft Corporation
ol Primary Contact Preferred Method of Contact
D&B360 Any
Details
NAE Credit i Credit Limit Annual Revenue
$73,723,000,000.00
Related
4 Common : Status Active

The results display in the D&B Contact Search window. The pencil icon displays for all contacts in the
list and indicates another contact similar to it exists. Consider whether to merge these contacts.

4. Next to the contact you want to merge, click the < pencil icon.

About D&B360
F Contact Search SRR DEESEE
)4 DEB Contact Search
D&B360
Search by Contact Name Search by Company Info
Contact Name D-U-N-S £02138570 Job Title L] acquisitions =
Company Mame Sony Corporation of America LI administration W
| Business Develop 3
Keywords
[4] | »
& = Existing Account fii\. = Existing Contact & = Existing Lead
[ | create contact Merge | [] create Lead | Full Name | company Name | Title | contzg

|| | click the pencil 4 L] Mary H Abram Sales & Marketing Manage  MName =
L [E- .} [ lean Abre: Western Regional Sales Ma  Name
L ..f L & Rhandy A Business Systems LiasonIni  MName
L 4 [ Ross A 0 Manager Contract Administ  Mame
|_| .) |_| Tax Director Marne
L] .} [ A Aganwa Business Development Ana  Name
[ v [ Diane A Corporate Accountant Mame
Il  d [ Brandon Akiate; Sonv Cornoration of Ar A Game Nesinner Name
1 | 3

5. Inthe D&B Contact Merge window, Existing Contacts list, decide if this is the existing contact you
want to pursue, then click OK.
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D&B Contact Merge =

m Existing Contacts About D&B360
D68

Choose a contact to merge Mary Abram into.
D&B360

FirstName | LastName | Title

(]

Rhandy Acuna Business Systems Liason International Op

| Click OK. : Ok | | Cancel |

6. Inthe Compare and Merge window, verify that the check marks display for any information you want
to retain after the merge so that it is not lost.

7. Click OK.
Merge contacts 5
About D&B360
Compare & Merge RROLR SREse
DEB)
D&B360
Field CRM Data D&E Data
First Mame L Rhandy L2 Mary
Last Mame W Acuna ‘2 Abram
Phone Mumiber bt [212) 833-6722 ‘2 (217) 833-6800
Email Address ) RHANDY.ACUMA@AME 2 MARYABRAM@AM,SOM
Title ' Business Systems Ligson ‘%' Sales & Marketing Manz

Ok | | Cancel
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In the following example, in the Merge contacts window, Compare & Merge list, we accept the First Name,
Last Name, Email Address, and Title from the D&B data. Because the D&B Contact Data does not have a
phone number, we selected the phone number in the CRM data. If we didn’t select that phone number, the
phone number we have would be overwritten with no data.

Merge contacts P

Compare & Merge About D&B360

D&‘B;ié‘(]
Field CRM Data D&B Data
First Name ./ Cyndi \%/) Cynthia
Last Name J Currie &) Currie
Phone Number 2/ (650) 857-1501
Email Address : 2/ CYNTHIACURRIE@HP.COM
Title CMO &) Chief Marketing Officer

4 »

Lok | [ cance |

Note: When you click Create to create a new contact, the People Credit Information
window opens to inform you of your current contact credits. To add the new contact,
click OK. If you decide not to use your contact credit for that contact, click Cancel.

People Credit Information E

You have 48 available out of 50 contact credits.

Do you wish to continue?

QK | | Cancel |
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With D&B360, you can leverage D&B data to enrich or add to your Lead information. In addition you can use
information from public sources to verify or enrich your Lead information.

LeVeraging RO . 6-2
Creatinga D&B360 Lead from a Contact ... ... . 6-2
Creating a Lead from an ACCOUNT L. L 6-4
Creatinga D&B360 Lead Manually ... . . 6-6

Manually Creating a Person as a Lead ... ... 6-6

Manually Creatinga Company as a Lead ... ... ... .. . 6-8
Creating a D&B360 Lead Based on a List of Criteria ... . ... . ... L 6-11
Creating a D&B360 Lead Based on Attributes of Specific Accounts ... ... .. . 6-12
Creating a Lead from a Competitor ... . . L 6-14

Note the following:

A gold star displays next to the first record and represents the Best Match found based on
your search criteria. The more details you provide, the better the results.

/A, Ayellow triangle with the letter A indicates an existing account.
B, A yellow triangle with the letter Cindicates an existing contact.

& A yellow triangle with the letter L or Oindicates an existing lead or opportunity.

Note: When you click or select the name of a company, a Company Overview window opens that
displays details about that company including D-U-N-S number, name, location, address, a synopsis, and
more.
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Leveraging ROW

You can use Rest of World (ROW) as an information source for news about a company and link to news
stories directly from the windows where you are working. For more information, see "Leveraging ROW" on

page 6-2.

Creating a D&B360 Lead from a Contact

If you have already established rapport with a contact, he or she would make a good lead for you. Or, a
contact at a specific company might be a good lead for you.

1. Inthe D&B360 tab, click Contacts with D&B360.

m leads  View  Charts  Add  Customize | D&B360

. |

E N Em E Click Contacts ﬁ

H™ |l :'""I"«B e _&.-.:J with D&BEED- l‘.__h

Accounts With Leads With Contacts With ild & About
DE&B360 DE&B360 DE&B360 List DE&B360
Create New DE&EB Build A List More Info

2. Inthe Search by Contact Name area, type the name of the contact for your search.
3. Click Search.

" Contact Search
pA: DB&B Contact Search
D&B360
Search by Contact Name

Contact Mame Glenda F anagan|

Search \I\SE-ﬂmh_

In the Search by Company Info area, D-U-N-S, Company Name, Job Title, or Keywords fields, type or
select your search options.

4. Click Search.
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Search by Company Info
O-U-M-5 Job Title

Ll ceEo =

T Whole Foods || CEO/President (Division, Regio —

¥l cFo |

Keywords |
[ 4] b

5. Next to the name of the contact in the Create Lead column, click to select the check box.
6. Click Create.

About DEB360
Contact Search SROLRDSESES
D&B Contact Search
D&B360
Search by Contact Name Search by Company Info
Contact Name D-U-N-S DEb R L] ceospresident (Divisio *
v |
Company Name Whole Foods o cro
| Chairman 3
Keywords
4| | 3
Sear Sear
A = Existing Account & = Existing Contact A = Existing Lead
|| Creste Contact | Merge | [] Create Lead | Full Name | Company Name | Title | Contact Details 2
I rd |} Chief Financial Officer Name & Title & Email
|| A |v] EVF and CFO Name & Title 8 Email
[} rd O Cfo Namne & Title
1| | 3
1 - 3 of 3 (1 selected) |4 4 Page 1 of 1 »
Create.

Note: If you want to create multiple leads or contacts, select more than one record from the list

that displays in this window. When you click Create, leads or contacts are created for all of the
records you selected.
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Note: When you click Create to create a new contact, the People Credit Information
window opens to inform you of your current contact credits. To add the new contact,
click OK. If you decide not to use your contact credit for that contact, click Cancel.

People Credit Information b=
You have 48 available out of S0 contact credits.
Do you wish to continue?

ok [| cancel |

0 Contacts and 1 Leads were created
Create Contact Create Lead MName Status

v,

—

Back to Results

The yellow letter A triangle displays only with Leads and indicates that an account already exists for the
company referenced in the lead. Before you add a person as a lead, you can see if that person is already a lead
for an account.

Creating a Lead from an Account
1. From the D&B360 menu, select Leads With D&B360.

leads  View  Charts  Add  Customize | D&B360
1

B B . y
= ' ™ with D&B360 aiald
Accounts With Leads With 5
DEEB360 DEEB360 g

Build & About
List DEB360
Create New DE&EB Build A List More Info

2. Inthe Search by Company Info area, Company Name, Country, and State/Province, fields, type or
select your search criteria. These fields are required.

3. Enter any other information you have about the existing account in the City, Address, Postal Code, and
Phone fields.

4. Click Search.
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" Create Lead
l.._._ﬁ D&B People or Company Search

D&B360

Search by Contact Name

Contact Name

Company Mame *

City
Address

Phone

Starbucks

Seattle

Utah Averue

About DEB360

Search by Company Info

Country * us -
State/Province * Wa -
Postal Code

==ty

5. In the D&B Company Results list, to associate your search for leads to a specific company, highlight the

appropriate row and click Select.

" Create Lead
Dé 5 D&B People or Company Search

Ao
D&B360
Search by Contact Name
Contact Name

Displaying D&B Company Results

Company Name *
City
Address

Phone

& = Existing Account & = Existing Contact A = Existing Lead

Starbucks

Seattle

Utah Avenue

About D&B360

Search by Company Info

Country * us -
State/Province * WA -
Postal Code

Match Info Company Address City State/Province Country Postal Code Phomz
& 2401 UTAH AVE S SEATTLE WA us 981341435 [20E) 44
2401 UTAH AVE 5 SEATTLE WA us 95134-1438 (503) 73
4| | 3
1-20of2 |4 4 Page 1 of 1 »

e

records you selected.

Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the

6. Inthe Create Lead window, select the lead you want to add, and then click Create.

©Dun & Bradstreet, Inc. 2014
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Create Lead About D&B360

D&B People Search

Search by Contact Name Search by Company Info
Contact Name D-U-N-5 155366107 Job Title L] Treasurer 3
Company Name STARBUCKS CORPORATION LI Vice Chairman
|| vice President 'l
Keywords -
=
Lt r Lt r

A = Existing Account & = Existing Contact A = Existing Lead

Company exists as a lead or account.

Full Name | Company Name | Title | Contact Details =]
Ay VP Global Communications ~ Mame & Title & Email
‘r& WP, Assistant General Coun:  Mame & Title & Email
& VP Corporate Social Resper Mame & Title
& Vice President Business Den Mame & Title & Email
1 - 4 of 4 (0 selected) |4 4 Page Click Create._
Return to Company Search | | Create |

The new lead is added to your D&B360 Leads.

Creating a D&B360 Lead Manually

When you run a D&B People search to create a lead, you can manually complete the process of establishing a
lead. You can also manually create a company as a lead.

Manually Creating a Person as a Lead
1. From the D&B360 menu, select Leads With D&B360.

leads  View  Charts  Add  Customize | D&B360
1

R Build & About
alistries List DE&B360

Accounts With Leads With
DEEB360 DEEB360

Create New DE&EB Build A List More Info

2. In the Create Lead window, Search by Contact Name area, type the name of the person you want to
create as a lead, then click Create.
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About D&B360
% Create Lead SROUL DSEIEE
»4:] D&B People or Company Search
D& B360
Search by Contact Name Search by Company Info
Contact Name Glendz Flanagan Company Name * | Country * United State w
City State/Province * -
Address Postal Code

Phone

Displaying D&B People Results

A = Existing Account & = Existing Contact A = Existing Lead

Full Name Company Name Title Contact Details z
Cfo Mame & Title o
Director Mame & Title x
4| »
1- 9 of 9 [0 selected) I4 4 Page 1 of 1 »

The Lead window for this lead displays information about your new lead.

In the D&B Lead and Contact windows, you can click D&B360 Person Biography to display
F information about a contact or lead. Or, when you click the name of a contact or lead, the
D&B;;]%rmn D&B360 Person Biography window opens and displays information about that contact or
Biography ~ lead. This includes the person's age, current employment, position in the company, business
services sector, and the company address and telephone number.
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D&B360 User Guide 6 Creating Leads with D&B360

44 Microsoft Dynamics CRM

Kelly Todd
Lead Add Customize DE&E36E0 DnE360_2.3_BetaRelease
LB OB B E =, - O i
H lﬁ g2 B L& T Egg gJ ﬁ @ Q i
Save Save & D&E D&B D&B360-= D&E D&E _DBLB_ D&B360 Person  Cualify  Add to Marketmg Connect A55|gn § Process Dc
Close Data ~ Refresh Competitors Industry Financials Biography e -
Save D& B360 Actions Collaborate
Information E/‘:D Lead Leads -l
Record Wall Glenda Flanagan
General Lead Source Rating Cwner
D&B360 Warm 8 Kelly Todd
D&k ROW
Cretails
Preferences * Record Wall
Motes & Activities
v General
Related Topic*
4 C?NT"-'O" Salutation Business Phone (510) 428-7400
|0 Adtivities
LE) Closed Activities First Name * Glenda Home Phaone
L?j] Connections Last Mame * Flanagan Mobile Phone
i3] Documents
= Audit History Job Title Cfo Fax
4 Marketing Company Name * Whale Foods Market California, Inc. Other Phone

In the D&B Lead and Contact windows, you can click D&B360 Person Biography to display
information about a contact or lead. Or, when you click the name of a contact or lead, the
D&E360 Person D&B360 Person Biography window opens and displays information about that contact or
Biography  lead. This includes the person's age, current employment, position in the company, business
services sector, and the company address and telephone number.

Manually Creating a Company as a Lead

1. From the D&B360 menu, select Leads With D&B360.

Leads View Charts Add Customize DE&B360
|
e T Soloct Loade | e
Accounts With Leads With ' Build A About
D&EB360 D&EB360 List D&EBE360
Create New D&E Build A List More Info

2. Inthe Create Lead window, Search by Company Info area, type the name of the company you want to
create as a lead.
3. Select the Country and State/Province.

Type in any other information for your search such as Address, Postal Code, and Phone.
5. Click Search.
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About D&B360

" Create Lead
L) ﬁ D&B People or Company Search

D&B360
Search by Contact Name Search by Company Info
Contact Name Company Mame * Dell Country * us -
City Round Rock State/Province * ™ -
Address Postal Code
Phane

E— Click Search.

6. In the list that displays, select the row of the company you want to create as a lead, and then click
Select.

Displaying D&B Company Results

/A\ = Existing Account A = Existing Contact A = Existing Lead

Match Info Company Address City State/Province Country Postal Code Phu z
Ay A 1 DELL WAY ROUMD ROCK T us 78682-7000 51
@ 1 DELL WAY ROUMND ROCK T® us 78682-7000
& 1 DELL WAY ROUMND ROCK T® us 78682-7000

1 DELL WAY ROUMND ROCK T Us 78682-7000 (51

501 DELL CENTER BLVD BLDG 2 ROUMD ROCK T us 78664-7306 (51

8200 M ALLEM RD ROUMD ROCK T us 78682-0001 (30

2300 GREENLAWN BLVD ROUMND ROCK T® us 78664-7090 (51

1 DELL WAY ROUMND ROCK T® us 78682-7000 (51

1 DELL WAY ROUMND ROCK T Us T8682-7000 (51

1 DELL WAY ROUMD ROCK T us 78682-7000 (51

1 DELL WAY ROUMD ROCK T us 78682-7000 (51

1 DELL WAY ROUMND ROCK T® us 78682-7000 (51
1 DELL WAY ROUMND ROCK T® us 78682-7000 (51—

1 DELL WAY ROUMND ROCK > us 78682-7000 (51

8200 N MO PAC EXPY STE 185 AUSTIN > us 78758-8866 (51

805 CASHEW LM CEDAR PARK T us 78613-3209 (51
1 DELL WAY ROUMD ROCK X us 78682-7000 (51

4| | 3
1-220f22 |4 4 Page 1 of1 p

o

Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the
records you selected.

7. In the Create Lead window, select the company, and then click Create <company name> as a lead.
The name of the company pre-populates this link; in this example, it is Dell USA Corporation.

To create one of the people in the Full Name list as a lead, click Create in the bottom right of the
window.
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Create Lead
1] D&B People Search
D& B360
Search by Contact Name

Search by Company Info

About D&B360

Contact Name D-U-N-5 603046210 Job Title | Acquisitions =
Company Name DELL U S A CORPORATION L administration -
L] Business Developm 3
Keywords
|4 | 3
A = Existing Account & = Existing Contact ,1'_\ = Existing Lead
Click Create <company name>
Create DELL U S A CORPORATION as a lead as a lead.
Full Mame | Company Name T e T Contact Details =)
Dell U § A Comporation Senior Program Manager Mame & Title & Email =
DellUS aticn Engineer Mame & Title —
DellUS on It Migr Mame & Title & Email
DellUS on Developer Mame & Title & Email
Dell US on Database Administrator Mame & Title & Email
DellUS on E N & Title & Email
"9 ame s mal OR: To cresate this
Mark Belcher Dell US A on Lab Manager MName & Title person as a lead, click
1 - 50 of &6 (0 selected) 4 4 EEE
Return to Company Search | | Create |
In the Create Lead window that opens, click OK.
Create Lead E%
About D&B360
F D&B360 ——
pA:  Create Lead
D& B360
Last Mame * DELL U 5 A CORPORATION First Mame
Title Phone Mumber
Email Address
Click OK.

©Dun & Bradstreet, Inc. 2014
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Creating a D&B360 Lead Based on a List of Cr

1. From the D&B360 menu, select D&B360 Build A List.

File D&E Lookups Wiew Charts Customize DEB360

——

o) ol B % Click Build
b E} b b ...... = A Li=t.
Accounts With Leads With Contads With D&E Build A
DEE360 DEE360 DEEB360 Industries List
Create New D&EB Build A List |

2. Inthe Build A List window, People section, enter your search criteria.
3. In any of the Company sections, enter search criteria.
4. To display a list of candidates, click People Search.

Build A List
LN

D& B360
Search | People Results | Company Results

Saved Search  -- None -- -
= People (Bio and Title Keyword, Job Title)

Keyword(s) in

Schultz | (=) Title (_) Bio Job Title [ []

e.g. marketing or Harvard or ad sales.

NEC

iteria

Abecut DABIED

Most Recent Search

3

Administration
Business Development _|
CEO

CEQ/President (Division, Region or Unit}

-

+ Company location (Country, US State/CAN Province, City and more)

Country ] United States > US State/CAN Province | sjabama =
[ amania L L] mlzska =
[ aigeria | Arizona
— L] Arkansas

-

1]

Us Metropolitan Area 10180 - Abiler *

L
L] 10380 - Agua i
| 10420 - Akror

-

Click
People :
Search.

| [
-

i
| People Search | |C[:m|:|an3|I Search|

5. Inthe Create Lead column next to the candidate you want to create as
box, then click Create.

©Dun & Bradstreet, Inc. 2014
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D&B360 User Guide
Build A List About D&B360
5 .A =
D&B360
Search | People Results | Company Results
Saved Search Save Current Search
& = Existing Account & = Existing Contact ‘i\‘ = Existing Lead
|| Create Contact | || Create Lead | Full Name | Company Name | Title | Contact Details =)
[ [} Md; Medical Director Tne C  Name & Title & Email
Partmer Bumns And Schultz |  Mame & Title

= @
1| |
|4 4 Page 1 ofl F

1- 2 of 2 (1 selected)
Click Create. Create

Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the

3

records you selected.

The new D&B360 lead is created.
About D&B3E0

Build A List

Ay
D& B350
Search

0 Contacts and 1 Leads were created

People Results | Company Results

| Status

v,

—

Back to Results

Create Contact Create Lead Mame

Creating a D&B360 Lead Based on Attributes of Specific

Accounts

1. Inthe D&B360 menu, select Accounts with D&B360, or on the left menu, select Customers ->

Accounts.

6-12
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4 Customers

Accounts With = Accounts
D&B360

2. In the list of your D&B360 accounts, click an account to select it.
3. In the Account window, click D&B Look-A-Like.

mEE R T 3 o

D&EB360+ D&EB D&B360 D&B DEB D&B D&E Collaborate Process Data
Contacts  View Look-A-Like Competitors Industry Financials - - -
DEE360
Click D&B
B Look-A-Like.
""._.. Account | Accounts - | i W
~ Starbucks Corporation
Primary Contact Preferred Method of Contact Owner
Any a Tech Support
Credit Limit Annual Revenue
$11,700,400,000,00
4. In the Build A List window, click People Search.
About D&E360

Build A List
DEE

D&B360

Search | People Results | Company Results |

Saved Search  -- Nane --

w |Save Current Search

~ People (Bio and Title Keyword, Job Title)

Most Recent Search | *

Keyword(s) in | (@ Title O Bio JobTitle | [ | acquisitions

[l administration

e.9. marketing or Harvard or ad sales.

D Business Development

[l cro

3

~ Company location (Country, US State/CAN Province, City and more)

US State/CANM Province US Metropolitan Area

O Virgin Island:
[ wvirginia
E Washington

= -

] united state *
[ albania
D Algeria
—

Country

Click People

b 1 * Search.

L] 10180 - Abi
[ 10380 - Agu
[ 10220 - akec

3

L
| Pecple Search | |-1:n::-rn|:|-an).I Search

©Dun & Bradstreet, Inc. 2014
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5. Inthe Create Lead column, click the check box next to the contact name you want to add, then click
Create.

Build A List
DEB)

D&BE360

About D&B3E0

Search | People Results | Company Results

Saved Search Save Current Search

|| create Contact | Merge | [l Create Lead | Full Name | Company Name | Title | Contact Details 2
- _) |+ Mary Cartwright YUM! Brands, Inc. Manufacturing Operations MName, title & email B
|| rd || Richard T. Carucci YUN! Brands, Inc, CFO Email -
1| | 3
801 - 1000 of 6022 (1 selected) 14 4 Page 5 of3l »

Click Create.

Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the
records you selected.

The new D&B360 lead is created.

( |(20)| Jd¢ hitps://dnbde... © ~ @ ¢ X ||g D] A iy X
\ .
Build A List ADout DAG360
D&EB360
Search | Pecple Results | Company Results
0 Contacts and 1 Leads were created
Create Contact Create Lead Mame | Status

Vv,

—

Back to Results

Creating a Lead from a Competitor

1. From the D&B360 menu, select Accounts with D&B360, or from the left menu, select Customers ->
Accounts.
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DE&E 4 Customers
—

|_-} Accounts

Accounts With
DéEB360

2. In the Account window, click D&B Competitors.
3. In the Competitors List window, next to the name of the person whose company you want to use as

o

your search criteria, click the i person icon.

" Competitors List About D&f
324 Competitors for Starbucks Corporation
D&B360

Matching Companies: 18

|| Create Account D-U-N-S Company City State/Province Country Annual Sales Is Top Compe
[} [ﬁ] R 258 Tim Hortons Inc, OCakville oM Canada §2,797.05
[} Eﬁ] HOEEITS illycaffé S.p.A. Trieste Italy 5379.34
] [ﬁ] g 013 Luigi Lavazza S.p.é. Turin Ttaly 5130431
[} [ﬁ] FEEEETA Mestlé 5.4, Vevey Waud Switzerland 5116,623.51 v
[} [ﬁl weREa7822 Caffé Nero Group Ltd. Londan United Kingdom 327275
[ [ﬁ] ARG5S Whitbread PLC Dunstable Bedfordshire United Kingdem  52,817.77
[ [ﬁ] wewEa3 A7 Greggs plc Mewcastle United Kingdom 5102448
[ [ﬁl g1 28 Dunkin® Brands Group, Inc. Canton A United States §628.20 w
[} Il T E20 International Coffee & Tea, LLC Los Angeles CA United States §195.10
- FERERDALE Caribou Coffee Company, Inc. Minneapaolis MM United States £326.50
] w7496 Cinnabon, Inc. Atlanta GA United States §17.50

Note: If you want to create multiple leads or contacts, select more than one record from the list
that displays in this window. When you click Create, leads or contacts are created for all of the
records you selected.

4. In the Create Contact window, next to the person you want to add as a lead, click to select the check
box, then click Create.
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If contact not found, create lead manually
|_| create Contact | Merge | [ Createead | Full Name | Company Name | Title | Contact Details o
[ v [ Brian Aliffi Caribou Coffee Company, Inc. Green Coffee Sourcing Sup Mame & title o
] _f [ Pam Asplund Caribou Coffee Company, Inc. Payrell Manager MName & title —
[ _f [ Renee Auseth Caribou Coffee Company, Inc. Compensation Manager, Hi  Mame, title & email
&) _f [ Peggy Bartholomew Caribou Coffee Company, Inc. ‘Warehouse And Logistics v Email
[ _f [ Laura Brunke Caribou Coffee Company, Inc. Marketing Assistant Name & title
|| _,? @ Kip R. Caffey Caribou Coffee Company, Inc. Director MName & title
| _f [ Sarah Palisi Chapin Caribou Coffee Company, Inc. Director MName & title o

4 | | 13

1- 79 of 79 (1 selected) 14 4 Page 1 of 1 p

The Create Contact window confirms that the new lead was created.

Create Contact

3,7 D&B People Search
D&B360
Search by Contact Name Search by Company Info
Contact Name D-U-M-5 801222456 Job Title
Company Mame Caribou Cof
Keywords
Search Search
0 Contacts and 1 Leads were created
Create Contact | Createlead | Name

©Dun & Bradstreet, Inc. 2014
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7 Using Build a List

You can use Build a List to specify the criteria that you want to apply to your searches, which help you identify
contacts, leads/competitors, new accounts, or information to help you enrich your existing accounts.

General SEarCh PrOCeSS .. ..o 7-1
Specific Criteria Collected . ... . 7-2
SaAVING SEANCN S . 7-3

Using a Saved Search ... 7-5

Note the following:

A gold star displays next to the first record and represents the Best Match found based on
your search criteria. The more details you provide, the better the results.

/R, Avyellow triangle with the letter A indicates an existing account.
B\ Ayellow triangle with the letter Cindicates an existing contact.

A A yellow triangle with the letter L or O indicates an existing lead or opportunity.

Note: To export Company Results to an Excel or other spreadsheet program on your local directory, click
the spreadsheet icon.

General Search Process

Click Build A List Decide if you are searching for people, such as contacts, or

i for companies.
Determine the type of search. or companies

©Dun & Bradstreet, Inc. 2013-2014 7-1
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Enter the search criteria. Enter the search criteria you want to use. Best Practice: The
more data you enter, the more focused your results

Click the appropriate button « If you're searching for people, click People Search.
o If you're searching for companies, click Company
Search.

After you execute your search, you save your search and use it later.

For more information about criteria to use for your searches, see the following table.

Specific Criteria Collected

PEOPLE SEARCHES
People Bio and Title Keyword Job Title
COMPANY SEARCHES
Company location Country (select from list) US State or CAN Province (select
from list)
US Metropolitan Area Global State or Province
City Zip or Postal Code
US or CAN Area Code Area around US Zip Code (# of
Miles)
Company size Annual Sales Growth — Total Employees (From/To)
$ mil (From/To)
Market Cap - $mil (From/To)
— More size criteria Annual Sales Growth — Total Employee Growth —
% (From/To) % (From/To)
Employees At This Location
(From/To)
Industry Industry Type (Primary Only — or — Primary and Secondary)
US SIC Code (type code) US SIC Code (select from list)
NAICS Code (type code) NAICS Code (select from list)
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Company type Public or Private (select form list)

Location Type (select Branch,
Headquarters, or Single Location)

Subsidiary Status (select from list)

Marketing Pre-screen (Select High,
Medium, or Low)

FINANCIAL DATA

— Key numbers Assets — $ mil (From/To)

R&D Expense — $ mil (From/To)

Ad Expenses — $ mil (From/To)

Net Income — $ mil (From/To)

Net Income — % (From/To)

Fiscal Year End (select from list)

— US IPO data Filing Date — MM/DD/YYYY

(From/To)

Trading Date — MM/DD/YYYY
(From/To)

Offer Amount — $ mil (From/To)

Price Range — $ (From/To)

Special criteria Company keyword (type text)

D-U-N-S Number (type text)

UK Registration Number (type
number)

UK VAT Number (type text)

Year of Founding or Change in Control — YYYY (From/To)

code), use a comma to separate multiple choices.

Note: For some categories you can select more than one choice. For data fields such as US SIC Codes (type

Saving Searches

1. From the D&B360 menu, select D&B360 Build A List.

——
D&E Lookups View Charts Customize D&B3a0
—
LB - Ll e Féa
Accounts With Leads With Contacts With D&E
D&E360 D&E360 DE&E360 Industries List

Create New

Click Build
A List
Build A

D&E Build A List |

2. Inthe Build A List window, People section, enter your search criteria.

3. In any of the Company sections, enter your search criteria.
4. To display a list of candidates, click People Search.

©Dun & Bradstreet, Inc. 2014
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E Build A List About D&E360
| DS

D&B360

Search |Peop|e Results | Company Results |

Saved Search - MNone -- w |Save Current Search Most Recent Search | *

= People (Bio and Title Keyword, Job Title)

k

kKeyword(s)in | genyitz | @© Title © Bio lobTitle | [} agministration

e.g. marketing or Harvard or ad sales.

D Business Development
¥l ceo

E CEOQ/President (Division, Region or Unit}

-

= Company location (Country, US State/CAN Province, City and more)

Country U5 State/CAM Province US Metropolitan Area

[ 10180 - Abiler
[ 10380 - Agua

[ United States *

[ apaniz

Alabama

Alzska

D Algeria Arizona Click D 10420 - Akror
"_‘ Arkansas People "_' 5
Search.

-

=
| People Search | |Cu::m|:|nan3|I Search

5. In the Build A List window, click Save Your Search to save this search.

E Build A List
D&E

D&B360

Search | People Results | Company Results

Click Save
Saved Search Cave Curent Search | &7 Current 5ﬂﬂFChJ
D Create Contaci | Merge | D Create Lead | Full Name & | Company Name | Title |
L 7i | Mary Cartwright YUM! Brands, Inc. Manufacturing Operations
] J ] Richard T, Carucel YUM! Brands, Inc. CFO
1l

6. Inthe Saved Search field, type a name for your search, and then click Save Search.

E Build A List
DéR

D&B360 Click Sawe
Search.
| Search | People Results | Company Results | L
— — v
Saved Search C My 5earch| ) I |Sal.re Seard1| |Cam:e| |
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Your search is now saved, and you can use it again at a later time. If you log off and want to go back
and save your search, you can log back in, execute the search, and then save it. Your last search is
preserved until you change it.

Using a Saved Search

1. Inthe D&B360 menu, select D&B360 Build A List.

File D&E Lookups Wiew Charts Customize DEB360

E =

Click Build

N ||_} ...... 9 ...... I'E A List.
Accounts With Leads With Contacts With D&E Build &
D&E360 D&E360 D&EB360 Industries List
Create New D&E Build A List |

2. In the Saved Search field, use the menu to select a search that you have saved.

Build A List
DB

D& B360
Search | People Results | Company Results

Saved Search  -- None -- - |5.a1.re Current Search

- People (Bi Title)
Austin Area CFO Search
Keyword(s) in |Search 1
I

£.0. marketing or Harvard or ad sales.

3. Click to select your saved search. The search criteria changes.
4. In the Build A List window that opens to your saved search, click the People Search or Company
Search.
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